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Introducing Film Factory

EPSON Software™ Film Factory™ lets you process your digital “film” and print 
snapshots using your own computer and printer. With this powerful photo 
management utility, you can import images from any digital-imaging source and 
create virtual rolls of film and film cases to organize thousands of photos in a 
visual format. 

Film Factory is the perfect photo management program for the home or office. If 
you’re a home computer user, you’ll have fun organizing, enhancing, printing, and 
sharing your favorite photos with family and friends. If you’re a small business 
user, Film Factory provides an efficient and convenient way to catalog your 
business-related digital photos.

Film Factory lets you:

� Quickly and easily import and organize images from a digital camera, scanner, 
PC card, CD-ROM, or disk.

� Retouch your pictures to make them look their best. Automatically adjust 
color balance, brightness, and contrast. Rotate or trim the image, or correct red 
eyes. Convert photos to black and white or sepia for a classic look. Most 
enhancements can be made without modifying the original image file. 

� Organize and retrieve all your photos with virtual “rolls of film” and “film 
cases.” You can catalog your photos by subject, or family members can have 
their own film cases with their own rolls.

� Print vivid color images in a variety of formats, including standard 3.5 × 5 or 
4 × 6 prints, an index (contact) sheet, photo album pages, and greeting cards. 

� Add comments or sound (Windows® only) to each photo to be stored with it. 

� Create photo collages. 

� E-mail your photos to family, friends, and business associates using your own 
e-mail program, or create web pages of your photos in one easy step (Windows 
only). 

� Use your photos as desktop wallpaper or a screen saver (Windows only).
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About PRINT Image Matching

If your digital camera and printer support PRINT Image Matching (P.I.M.), Film 
Factory lets you produce the best prints possible (not available on Macintosh® 

OS X). PRINT Image Matching is a term for the print command that is 
embedded in the header of the image file created by certain digital cameras. It 
contains color setting and image parameter information. With PRINT Image 
Matching, the digital camera can set specific printing options such as:

The camera saves this information in each image file. For example, macro mode 
pictures might include commands for sharpness and clarity, while portrait mode 
pictures might emphasize soft focusing and subtle flesh tones. Your printer then 
uses the information to ensure the most accurate reproduction of the image.

In Film Factory, the P.I.M. symbol appears on the thumbnails for PRINT 
Image Matching photos. You can also right-click (Windows) or Ctrl-click 
(Macintosh) a photo thumbnail to see if it is a P.I.M. photo. Check the Photo 
Enhancement status in the displayed information; if it is PRINT Image Matching 
or PRINT Image Matching with the ability to interpret Exif Print, the photo 
contains P.I.M. data.

If a PRINT Image Matching photo has been retouched, it may not display the 
P.I.M. symbol or P.I.M. status. If you trim or rotate a PRINT Image Matching 
photo, or correct for red eyes, the P.I.M. settings are retained. But because P.I.M. 
optimizes settings such as brightness and color automatically, using retouching 
options like these removes P.I.M. settings. You also lose P.I.M. settings if you 
export the files.

About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG files so your printer and application can use them 
to create accurate print settings. Most digital cameras store Exif Print information 
such as shutter speed, metering, flash and exposure settings, resolution, and lens 
use in the JPEG image file.

� contrast � sharpness � brightness

� gamma level � color space � color saturation

� shadow � highlight � color balance
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In Film Factory, Exif Print or PRINT Image Matching with ability to interpret 
Exif Print is listed in an information display box as the Photo Enhancement status 
when you right-click (Windows) or Ctrl-click (Macintosh) an Exif Print photo. 
Like P.I.M. photos, you can trim, rotate, or correct for red eyes and still retain Exif 
Print settings, but if you adjust brightness or color options, or export the files, the 
Exif Print settings are removed.

Learning More About Film Factory

� This Getting Started guide explains how to use Film Factory’s exciting features.

� Click the Film Factory Help button for step-by-step instructions on the most 
frequently used features and convenient access to detailed information. 

� If you need additional EPSON® Support, see “Where to Get Help” on 
page 60.

Windows System Requirements

If you’re using Windows, make sure your system configuration meets these 
minimum requirements:

� Windows 95, 98, Me, XP, 2000, or NT 4.0

� Pentium® 200 (or equivalent) processor or higher

� 64MB of RAM (more will improve performance)

� 100MB of available hard disk space, not including photo storage

� SVGA monitor with 16-bit (High Color) display adapter or better

� QuickTime® 4 or higher to support some file types

� Mouse or other pointing device

� Compatible with most color printers; a high-quality photo printer and special 
media are recommended to print the best images

� A PRINT Image Matching- or Exif Print-enabled digital camera and printer 
are required to print with P.I.M. or Exif Print technology

If you’re using Windows XP, 2000, or NT 4.0, you may need to have 
Administrator privileges to install and use Film Factory.



8

Macintosh System Requirements

If you’re using a Macintosh, make sure your system configuration meets these 
minimum requirements:

� Mac OS 8.5.1 through 9.x for Film Factory for Mac OS 8/9

Mac OS X 10.1 or higher for Film Factory for Mac OS X

� 233 MHz G3 processor or higher

� 64MB of RAM (more will improve performance)

� 100MB of available hard disk space, not including photo storage

� 800 × 600 display resolution with Color Depth set to “thousands of colors”

� QuickTime 4 or higher

� HTML browser (such as Microsoft® Internet Explorer or Netscape® 
Navigator® version 4.0 or higher) to view online help

� Mouse or other pointing device

� Compatible with most color printers; a high-quality photo printer and special 
media are recommended to print the best images

� A PRINT Image Matching- or Exif Print-enabled digital camera and printer 
are required to print with P.I.M. or Exif Print technology

Compatible Devices and File Formats

Film Factory supports files from all TWAIN-compatible digital cameras and 
scanners (not available with Macintosh OS X). For non-TWAIN devices, you can 
download photos using your camera or scanner software.

Film Factory supports the following digital photo file types:

� Windows: Supports BMP and JPEG file types. If QuickTime 4 or higher is 
installed, also supports TIF, PCX, FPX, Photo CD (read only), MacPaint,® 
PNG, GIF, PICT, Adobe® Photoshop,® QuickTime, SGI, and Targa files.

� Macintosh: Supports JPEG, PICT, BMP, TIF, FPX (read only), PNG, GIF 
(read only), MacPaint, PhotoShop, QuickTime, SGI, and Targa files.

If QuickTime 4 or higher is installed, Film Factory supports the following digital 
movie formats: QuickTime, DV, MPEG1, and AVI files. 
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Starting Film Factory

To start Film Factory in Windows, click the Start button and select Programs or 
All Programs. Then select Film Factory > Film Factory.

To start Film Factory on a Macintosh, open the Film Factory folder and 
double-click Film Factory or Film Factory OS X to open the program. 

You see the main screen.

Film Factory’s Main Screen

The main screen displays thumbnail views of the photos in the open roll. (The 
Sample roll included with Film Factory is shown below.)

Film 
cases

Menu commands Toolbar tools

Print 
options

Roll of film

Photo

Status bar

PRINT Image 
Matching icon



10

Toolbar

Click on any tool to perform its function. Hold the mouse cursor briefly over any 
tool to see what function it performs.

Menu commands

The menu commands provide another way to access many of the toolbar 
functions, as well as some additional features. Open any menu to select a 
command. The Status Bar describes the command.

Film cases

Create separate film 
cases to catalog your 
rolls by subject.

Select a film case by 
choosing it from this 
list. Only the rolls in 
that case are displayed.

Print options

Click on one of the 
Print options to 
select how you want 
to print your 
photo(s).
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Status bar

The status bar describes the selected menu command and displays information 
about your photos.

Photos 

Click on any photo to select it. Selected photos are highlighted by a yellow 
background. 

PRINT Image Matching photos have an  icon in the upper-right corner. 
(PRINT Image Matching features are not available on OS X.)

Display information about photos by right-clicking 
(Windows) or Ctrl-clicking (Macintosh) the photo 
thumbnail. The P.I.M. or Exif Print status of the photo is 
listed under Photo Enhancement.

Select photos individually, or select a group of photos using 
Shift + click or Ctrl + click (Windows), or Shift + click or 

 

J + click (Macintosh).

Click All or Cancel to select or deselect all the photos in a roll.

Double-click on a photo to display an enlarged view of it. (You can also use the 
Viewer option to enlarge a photo. See “Using the Viewer to Display Photos” on 
page 29.)

Film rolls 

Add photos to your 
rolls and view them by 
simply clicking on a 
roll. The current roll is 
highlighted by a 
yellow background.

Scroll bars

Use the scroll bars 
or click on the 
arrows to see 
more rolls and 
more photos.
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How Film Factory Organizes Your Photos

Film Factory helps you organize photos already stored on your computer as well as 
those you add from other sources—your digital camera, scanner, or removable 
media such as a PC card, Zip® disk, or CD-ROM. 

First you create a film roll, to which you add your photos. You can store as many 
photos as you want in each roll. When you have a number of rolls, you can file 
them in virtual film cases; group rolls of film by subject to make it easier to 
manage your photos. 

Additionally, large photo files don’t have to take up space on your hard drive. You can 
keep them on your Zip disk, CD-ROM, or other removable media while adding 
virtual thumbnail images of them to a roll created on your hard disk. For example, if 
you have your photos developed and returned to you on a CD-ROM, you can create 
a roll without storing the actual photos on your hard drive.

Likewise, if you have images stored on a network, you can view thumbnail 
versions of the photos (along with any comments) even when the network is 
offline.

For more information, see “Managing Your Photos, Film Rolls, and Film Cases” 
on page 29.

Creating a Roll of Film

Follow the instructions in this section to create a new roll of film and add photos 
to it—from a disk or from a device such as a digital camera. You can also create a 
new roll by copying images from an existing folder on your hard disk or other 
device.

1. From the Main Menu, click the Roll button. You see this menu:
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2. To create a new roll to which you can add photos later, click New Roll. You see 
this dialog box:

Type a name for the roll. If you want to add a comment and/or date to 
describe the roll, click the Details button and enter the comment and date. 

To create a roll from an existing folder of images, click New Roll, Use 
Existing Image Folder. You see this dialog box:

Select the drive and/or folder where the photos are stored. (On the Macintosh, 
click Browse, then select a folder and click Choose.) 

IThe photos are not copied to your hard drive; only thumbnail images are 
created for the roll.

Click here to add 
a comment and 
date for the roll

Click here to add a 
comment or change 
the date

Click here to add a 
comment or 
change the date

Click Browse to 
select a folder

Windows

Macintosh
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If you want to enter a name for the roll that is different from the folder name, 
type it in the Roll Name box. 

If you want to add a comment and/or date to describe the roll, click the 
Details button and enter the comment and date.

3. Click Add. The roll appears on the main screen. 

If the folder is on a removable 
device such as a Zip disk or 
PC card, you see this window:

If you can record on the 
device, you can copy the Film 
Factory databases to the 
device. Check the Copy Film 
Factory databases to the 
removable media checkbox 
(Windows) or the Write Film 
Factory databases to the 
removable media checkbox 
(Macintosh) to record the film 
case, film roll, and any other 
photo information on the 
removable device. 

With Macintosh OS X, it’s 
best to copy your photos 
to a folder on your hard 
disk and manage your film 
rolls from there.

If you create a roll from a folder on a removable device, this icon  
appears in the upper right corner of the roll. 

Now you are ready to add photos to the roll. 

Windows

Macintosh
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Adding Photos to a Roll

To add photos to a roll, you select images already stored on a disk or from other 
sources such as a digital camera or scanner. First, make sure the import settings are 
correct. Then see the appropriate section below:

� “Adding photos from a folder on the hard drive” on page 16.

� “Adding photos from a TWAIN device” on page 17.

� “Adding photos from removable media or a PC card” on page 17.

Selecting the Import Settings

Follow the steps below to define the import source for your image files, whether 
they are on your hard disk, digital camera, scanner, PC card, or other removable 
device. You need to do this only once.

1. Click the Import button, and choose Import Settings. You see this window:

2. On the File tab, click Browse and select the path name where your image files 
are stored—on your hard disk, removable media, and/or PC card. This 
becomes the default path where Film Factory will look for files when you 
import them, but you can always specify a different location.
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On the TWAIN tab, select the digital camera or scanner you are using from 
the Import Source List and the file format (BMP, PICT, or JPEG). Then click 
OK. (TWAIN importing is not available on Macintosh OS X.)

For more information about Import Settings, click the Help button.

Adding photos from a folder on the hard drive

Follow these steps to import photos from another folder:

1. From the Main Menu, select the film roll to which you want to add photos. 

If the film roll you want is in another 
film case, click the down arrow on 
the Film Cases icon to display the 
other film cases. 

2. Click the Import button, then select 
From File from the drop-down menu. In Windows, you see the Import Files 
window; on a Macintosh, you see the Choose a File window.

3. Navigate to the disk and directory where the photos are stored. 

4. Click the filename you wish to add. A thumbnail of the photo appears in the 
Preview window. You can select more than one with Shift + click or Ctrl + click 
(Windows), or Shift + click or 

 

J + click (Macintosh). Click Select All to 
select them all.

5. Do one of the following to add photos to your roll:

� Click Move to remove the originals from their source and move them to 
the folder where Film Factory stores images.

� Click Copy to leave the originals where they are and place a copy in the 
folder where Film Factory stores images.

The photos appear in the roll.

6. On a Macintosh, click Choose or Open.

Click here to see 
other film cases
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Adding photos from a TWAIN device

Follow the steps below to download photos using a TWAIN device, such as a digital 
camera or scanner (not available with OS X). Film Factory works with all digital 
camera image formats.

Make sure your device is TWAIN compliant before you try importing photos. 
The device should be connected to your computer and ready to use. See the 
instructions that came with your device for help.

To import photos from your camera or scanner:

1. From the Main Menu, select the film roll to which you want to add photos.

If the film roll you want is in another 
film case, click the down arrow on 
the Film Cases icon to display the 
other film cases.

2. Click the Import button, and choose 
From TWAIN Device. The software used to transfer photos from your camera 
or scanner to your computer is started.

3. Import your photos to the selected roll of film using the software that was 
started. See the instructions that came with the software for help.

Adding photos from removable media or a PC card

Follow the steps below if you want to import files from a removable device such as 
CD-ROM, Zip disk, or PC card.

With Macintosh OS X, it’s best to copy your photos to a folder on your hard 
disk and manage your photos from there.

1. Insert the disk in the appropriate drive.

2. From the Main Menu, select the film roll to which you want to add photos.

If the film roll you want is in another 
film case, click the down arrow on 
the Film Cases icon to display the 
other film cases.

Click here to see 
other film cases

Click here to see 
other film cases
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3. Click the Import button, then select From Removable Media or From PC 
Card from the drop-down menu. The Import Files (or Choose a File) window 
appears.

4. Navigate to the disk and directory where the photos are stored. 

5. Click the filename you wish to add. A thumbnail of the photo is displayed. 
You can select more than one with Shift + click or Ctrl + click (Windows) or 
Shift + 

 

J + click (Macintosh). Click Select All to select them all.

6. Do one of the following to add photos to your roll:

� Click Move to remove the originals from their source and move them to 
the folder where Film Factory stores images.

� Click Copy to leave the originals where they are and place a copy in the 
folder where Film Factory stores images.

The photos appear in the roll.

7. On the Macintosh, click Choose or Open.

Retouching Your Photos

You can retouch your photos to improve the quality or add special effects. Film 
Factory can automatically retouch photos for you or you can do it yourself 
manually. In most cases, retouching does not modify the original photos.

When you click the Retouch button, you see this menu:

� To retouch photos automatically, see page 19.
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� To manually change the brightness, contrast, and color, see page 20.

� To rotate a photo, see page 21.

� To crop a photo, see page 22.

� To change the color to black and white or sepia tone, see page 23.

� To enhance the image with soft focus, see page 24.

� To correct red eyes in a photo, see page 25.

� To cancel retouching, see page 26.

If you retouch a PRINT Image Matching or Exif Print photo, depending on 
how you retouch it, it may lose its PRINT Image Matching or Exif Print data. 
To restore the PRINT Image Matching or Exif Print data, use the Cancel 
Retouch option in the Retouch menu. If you overwrite the original image 
when you retouch the photo, you can’t restore the PRINT Image Matching or 
Exif Print data (not applicable to OS X).

Automatically Retouching a Photo

When you let Film Factory automatically retouch a photo, the program adjusts the 
color balance, brightness, and contrast.

1. Select the roll and then the photo(s) you want to retouch.

2. Click the Retouch button and then select Auto Retouch. 

3. The Auto Retouch window shows the photos you selected before and after 
retouching. All the retouched photos are outlined with a blue border, 
indicating that they are selected to be changed. 

Before After
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You can do the following:

� Click on any of the original photos in the top row that you do not want to 
be retouched. They will display the blue border when you click them.

� Use the horizontal scroll bar to see more photos, if necessary.

� Click Select All in either row to select all the images in that row. 

� To replace the original photos, check the Overwrite Original Image box. 
These changes cannot be reversed. Otherwise, you can undo retouches with 
the Cancel Retouch command on the Retouch menu. (The retouching 
information is stored in the Film Factory database.)

4. Click Make Changes. The photos are retouched.

Manually Retouching a Photo

If you want greater control when retouching an image, follow these steps: 

1. Select the roll and then the photo you want to retouch.

2. Click the Retouch button and select Manual Retouch. You see this window:

Enlarge the 
photo

Undo the last change Click here when you are ready to 
save the changes

Cancel your changes and close the 
Manual Retouch window

Check this box to change 
the original photo

Use the 
sliders to 
change the 
brightness 
and contrast
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3. Click the Brightness tab to adjust the brightness and contrast. Click the 
Color tab to adjust the red, green, and blue values in the image. 

You can either use the sliders to make the adjustment or select the image you 
like best from the 9 choices displayed.

4. If you want the changes to be made to the original photo file, check the 
Overwrite Original Image box.

5. When you are happy with the changes, click the Retouch button. 

Rotating an Image

You can rotate an image 90° or 180° as follows:

1. Select the roll and then the photo(s) you want to rotate.

2. Click the Retouch button and then select Rotate. You see the following:

3. Select the rotation you want (CW 90°, CCW90°, or 180°) and then click the 
Rotate button. (Click Rotate All if you want to rotate all the selected images.)

4. If you want to rotate the original photo file, check the Overwrite Original 
Image box.

Rotate the image 
clockwise 90°

Rotate the image 
counterclockwise 90°

Rotate the image 180°

Check this box to 
change the original 
photo

Rotate all the selected imagesRotate the image

Skip the current photo 
and display the next 
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Cropping an Image

You can crop an image to make it more effective. Follow these steps:

1. Select the roll and then the photo(s) you want to crop.

2. Click the Retouch button and select Trim. You see this window:

3. Select one of the trim tools on the right side of the window to select the crop 
format you want. Then place the cursor on the frame line and move the 
borders in to crop the image. You can move the box around to capture the 
desired part of the photo.

Make sure the proper photo format is selected in the Aspect Ratio pull down 
menu. (For more information, click Help.)

4. When the image is framed like you want, click the Trim button to crop it.

If you want to crop all the selected images the same way, click Trim All.

Crop the image 
as selected

Landscape

Skip the current 
photo and display 
the next 

Crop all the selected images as 
marked on this image

Select landscape or 
portrait automatically

Portrait

Auto trim for scanned 
transparency

Display trimming 
information window

Overwrite original file

Undo cropping (after 
trimming and clicking the 
Trim button)
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If you don’t like the way the picture is cropped, click Skip to go to the next 
picture or Cancel to close the Trimming window. If you clicked Trim already 
and want to cancel it, select the image and select Trim from the Retouch 
menu. Then click the  tool to undo it and click the Trim button.

Changing Color to Black and White or Sepia

You can turn your color photos into black and white or sepia tone images. Follow 
these steps:

1. Select the roll and then the photo(s) you want to retouch.

2. Click the Retouch button and then select either Black & White or Sepia. 
You see this window:

3. The window shows the photos you selected before and after changing the tone. 
All the retouched photos are outlined with a blue border, indicating that they 
are selected to be changed. You can do the following:

� Click on any of the original photos in the top row that you do not want to 
be changed. They will display the blue border when you click them.

� Use the horizontal scroll bar to see more photos, if necessary.

� Click Select All in either row to select all the images in that row. 
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� To replace the original photos, check the Overwrite Original Image box. 
These changes cannot be reversed. If you don’t replace the original photos, 
you can undo retouches with the Cancel Retouch command on the 
Retouch menu.

4. When you are ready, click Make Changes. The photos are retouched.

Applying a Soft Focus Effect

Follow these steps to give your photos a soft focus effect:

1. Select the roll and then select the photo(s) you want to retouch.

2. Click the Retouch button and select Soft Focus. You see the following:

3. Use the slider to increase or decrease the soft focus effect. 

4. When you are happy with the image, click Run. If you selected more than one 
photo, the next one is displayed.

Skip the current photo 
and display the next 

Cancel and close the Soft 
Focus window

Apply the soft 
focus effect

Use the slider 
to soften the 
image

Check this box if you 
want the changes to 
be made to the 
original image
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Correcting Red Eye

If you have a photo of a person whose eyes appear red from the reflection of the 
camera’s flash, you can correct them as described below.

Any changes you make are made to the original photo and cannot be undone. 

1. Select the roll and then the photo(s) you want to retouch.

2. Click the Retouch button and select Red Eye Correction. You see the 
following:

3. Use the Zoom slider to enlarge the photo.

4. Use your mouse to click on the eye area, then drag the ellipse shape to define 
the area you want to adjust.

5. Use the sliders to increase or decrease the brightness or hue.

6. When you are done, click Correct to apply the changes to the photo.

If you change your mind, click Cancel to cancel the changes and close the 
window.

Use the slider 
to zoom in on 
the eyes

Adjust the 
brightness 
and hue

Undo the last 
adjustment

Apply the changes Cancel the changes and 
close the window



26

Canceling Retouch Changes

If you change your mind after retouching your photo(s), follow the steps below to 
remove the retouching effects and restore the original photo.

If you checked the Overwrite Original Image box when you made the 
changes, you cannot cancel the retouch changes.

1. Select the photo(s) for which you want to cancel the retouching.

2. Click the Retouch button and select Cancel Retouch. You see this window:

3. The first image you selected is displayed. Check the boxes for the effects you 
want to cancel.

If you want to leave this image unchanged and go on to the next, click Skip.

4. When you are ready, click Run to cancel the retouching. If you want to cancel 
the retouching on all the selected photos, click Run All. You see a confirmation 
window. Click OK again.

Check the 
retouch 
effects you 
want to 
cancel

Overwrite the 
original image 

Cancel the selected 
retouch effects on the 
image displayed

Skip this image and 
display the next

Remove the retouch 
effects on all the 
selected photos

Cancel and close the window
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Adding Comments or Sound to a Photo

You can annotate your photos with text and the date to help identify them. If you 
are using Windows, you can also add sound.

Adding Text

1. Select the photo(s) to which you want to add a comment. 

2. Click the Text button. You see the Edit Information window:

3. Enter the information you want for this photo. Then click OK. If more than 
one photo was selected, you see the next one.

If you don’t want to enter or change any information for this photo and you 
selected more than one, click Skip to go to the next one.

Type your 
comments here

Copy the comment 
or date from the 
previous photo

Display the next photo

Copy all data 
from the 
previous photo

Copy the current information to 
all selected photos

Enter the 
correct date 
and time
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Adding Sound (Windows Only)

1. Select the photo to which you want to add sound.

2. From the Edit menu, select Edit Sound. You see this window:

3. Click on the red button and then start recording. When you finish, click OK.

You see a speaker icon in the upper right corner of the photo:

Click the speaker icon to play the sound for a photo. You can also select the photo 
and then choose Play Sound from the Edit menu.

To delete the sound from a photo, select the photo and then choose Delete 
Sound from the Edit menu.

Click here to start recording
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Managing Your Photos, Film Rolls, and 
Film Cases

The more rolls and cases you create, the more important it will become to organize 
them. Film Factory makes it easy to move, copy, and delete photos, film rolls, and 
film cases. It also features convenient ways to view your photos, find missing ones, 
or sort them by name or date.

Using the Viewer to Display Photos

When you want to see a picture in detail, use the Viewer option. Select one or 
more photos and then click the Viewer button. (You can also double-click on the 
photo.) The first photo appears enlarged on the screen with this toolbar on top:

You can do the following:

� Click Next or Prev to display the other photos if you selected more than one.

� Click Window to display the photo in the current window. 

� Click Original to display the image at the resolution it was taken.

� Click Screen to use the whole screen for the image.

� Click Slide to run a slide show of the selected photos. (See “Creating a Photo 
Slide Show” on page 56 for more information.)

� Click Exit to close the Viewer.
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Moving or Copying a Photo to Another Roll

You can easily move or copy photos from one roll to another. 

To copy a photo, make sure both the roll you want to copy from and the roll you 
want to copy to appear in the Film Factory window. (Select All Rolls under Film 
Cases to display all your rolls.) Then select the photo you want to copy and drag 
and drop it to the other roll. You can select multiple photos at once.

To move (or copy) photos to another roll (folder) follow these steps:

1. Select the roll and photo(s) you want to move or copy. 

2. From the Edit menu, select Move/Copy Photo. You see this window:

3. In Windows, type the name of the folder where you want to move or copy the 
photo or click the Browse button to navigate to the correct folder. 

On the Macintosh, click Browse and select the folder to which you want to 
move or copy the photo, then click Choose.

4. Select Move to move the photo or select Copy to make a copy of it.

5. Click the Move/Copy button.

You can also add a photo to an existing roll by importing it, as described under 
“Adding Photos to a Roll” on page 15.
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Deleting a Photo From a Roll

If you want to delete one or more photos from a roll, follow these steps:

1. Select the roll and then the photo(s) you want to delete.

2. Select Delete Photo from the Edit menu.

3. At the confirmation window, click Yes.

The photo is deleted from the roll.

Finding a Photo

If you are not sure where to find a particular photo, Film Factory can help. Click 
the Find button or select Find Photo from the Edit menu. You see this window:

You can search for the image by filename, comment, or date. For example, if you 
know the name of the file but not which roll it’s in, click the filename checkbox, 
type the name, and press Enter. Film Factory finds the file and displays the 
complete information in the Search Results box.

If you know only part of the filename, you can type just the part you know 
and Film Factory will find any photos with matching characters in the name.
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Sorting Photos and Film Rolls

When you are looking at a roll of photos, you can sort them by name or date, in 
ascending or descending order. From the View menu, select Sort Photos or 
Sort Rolls and then select the sort method.

Renaming a Roll

Follow these steps to change the name of an existing roll:

1. Select the roll you want to rename.

2. Click the Roll button and select Rename Roll.

3. Type the new name for the roll. You can also add a comment, specify the date, 
and change the folder where you want the roll to be stored.

If the roll is stored on a removable media device, you can enter the name for 
the disk and select whether you want Film Factory to record its databases to 
the disk. If you copy the databases, Film Factory records the film case, film 
roll, and any other photo information on the removable device so this 
information stays with the photos. 

4. When you are done, click Rename.

Moving a Roll

Follow the steps below to move a roll of photos to another folder on your hard 
disk (or other device).

If you want to move a film roll to another film case, see “Moving a roll to 
another case” on page 35.

1. Select the roll you want to move.

2. Click the Roll button and select Move Roll.

3. In Windows, type the name of the folder where you want to move the roll (or 
click Browse to find it). 

On the Macintosh, click Browse and select the destination folder, then click 
Choose. 
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You can also add a comment, specify the date, and change the folder where you 
want the roll to be stored. 

If you are moving the roll to a removable media device, you can enter the name 
for the disk and select whether you want Film Factory to record its databases 
on the disk. If you copy the databases, Film Factory records the film case, film 
roll, and any other photo information on the removable device so this 
information stays with the photos. 

4. When you are done, click Move.

If you’re not sure where a film roll is stored, right-click your mouse (Windows) 
or Ctrl + click (Macintosh) to display information about the roll including its 
location.

Deleting a Roll

If you want to delete a film roll, follow these steps:

1. Select the roll you want to delete.

2. Click the Roll button and select Delete Roll. You see this window:

When you delete the roll, Film Factory does not delete the files from your hard 
disk or removable device unless you uncheck the “Don’t delete image files...” 
box. So make sure this box remains checked if you want to keep the image 
files.

3. When you are ready, click Delete.

Leave this box checked 
unless you want to delete 
the file from your hard 
disk or removable device
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Working With Film Cases

Film cases allow you to group rolls of film by subject to make it easier to manage 
your photos. Follow the instructions below to create, move, and delete a film case.

Creating a film case

Follow these steps to create a film case:

1. Click the Film Cases text on the Film Cases icon. 

You see this window:

2. The rolls of film with the check marks are the ones kept in the selected film 
case. A roll can appear in more than one film case.

3. Click the Add Case button. Enter a name and click OK. The new case name is 
added on the left side.

4. To add rolls to the new case, click the check box for each roll you want to add. 
If you change your mind, click the box again to uncheck it.

5. When you are finished, click Close. The new case is selected automatically.

To display all existing rolls in all cases, select All Rolls from the Film Cases drop-
down list.



35

Moving a roll to another case

If you want to move a film roll to another case, follow these steps:

1. Click the Film Cases text on the Film Cases icon. 

2. Select the film case holding the roll you want to move.

3. Click on the check box next to the roll to uncheck it. 

4. Select the case where you want the roll to appear and click the check box for 
the roll.

5. Click Close.

Deleting a film case

Follow these steps to delete a film case:

1. Click the Film Cases text on the Film Cases icon. 

2. Select the case you want to delete in the Film Cases window.

3. Click Delete Case. 

4. When you see the confirmation window, click OK. The case is deleted from the 
Film Cases window.

5. Click Close.

Although the case is deleted, the film rolls and photos are left unchanged.
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Managing Photos on Removable Media and 
Networks

Large photo files don’t have to take up space on your hard drive; just store them on 
your Zip disk, CD-ROM, or other removable media. If, for example, you have your 
photos developed and returned to you on a CD-ROM, you can create a roll without 
storing the actual photos on your hard drive.

Likewise, rolls for network images can be viewed as thumbnails and searched by 
photo comments even when the network is offline. Rolls of film that are stored on 
removable media or network drives have an icon in the corner that indicates where 
the rolls are located.

When you want to print an image, a message appears telling you the name of the 
media disk where the file can be found. Just insert the disk to continue printing.

Network drive iconRemovable media icon
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Printing Your Photos

This section describes how to print your photos using the print options displayed 
along the left side of the main screen.

Before you start printing, check your printer documentation to make sure you 
load the paper correctly in your printer and select the correct paper size and other 
printer settings.

Print Option Description Page

Print one or more photos in standard picture 
sizes, such as 2 × 3, 3.5 × 5 (standard), 4 × 6, etc.

38

Print an index (or “contact”) sheet of selected 
photos.

40

Print duplicate copies of selected photos. You can 
specify the number of duplicates for each photo.

42

Print selected photos in a photo album layout, 
and add captions to the photos.

44

Print photos in greeting card layouts with or 
without text.

47

Print a sheet of stickers, including frames and 
other graphics, for a selected photo.

51

Print a single image 3, 4, or 5 times on a sheet 53
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Standard Prints 

You can print one or more photos in standard picture sizes, such as 2 × 3, 
3.5 × 5 (standard), or 4 × 6. Use this feature to print photos from an existing roll. 
You can also create a new roll of film, import photos, and print—all in one step.

1. Click Standard Prints. 

2. Step 1 Select Roll is highlighted. Select the roll containing the photo(s) you 
want to print.

3. Click Step 2 Import & Retouch. Click on the photo(s) you want to print.

4. Click Step 3 Print Assignment. You see this window:

Select the size of print, such as 2 × 3 or 4 × 6. Use the scroll bar to see more 
options. Choose any options in the Print Preferences box you want to use. 

If you want to create a roll at this time, click the Roll button and choose 
one of the New Roll options. (See “Creating a Roll of Film” on page 12 
for more information.)

If you want to add a photo to this roll, click the Import button and choose 
the option you want. (See “Adding Photos to a Roll” on page 15 for 
more information.) Imported photos are automatically retouched.

Select the 
layout

Check the 
printer 
settings

Select 
whether to 
print a 
border, date, 
or crop marks
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With Windows and Macintosh OS 9.x, check the Printer Settings. If the 
Printer, Media Type (EPSON printers only), or Paper Size setting is incorrect, 
click the Properties button and select the appropriate setting. (See your 
printer documentation for details.)

With Macintosh OS X, click the Properties button. Select your printer in the 
Format for menu, then select the correct Paper Size setting. (Once you’ve 
selected your printer, you can select your paper size as the Media Size setting on 
the Film Factory screen.)

5. Click Step 4 Print. You see this screen:

6. Choose the number of copies you want. Film Factory tells you how many 
sheets of paper are required. You can click the Detailed Preview button to see 
the image enlarged. 

Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M. and/or Exif Print data (not 
applicable to OS X).

7. When you are ready, click .

If these checkboxes are selected, leave them checked for 
the best printed output using P.I.M. and or Exif Print data
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With Macintosh OS 9.x, you see the printer settings window. Click Print.

With Macintosh OS X, you see the printer settings window. Select Print 
Settings from the Copies & Pages pull-down menu. Then select your Media 
Type (EPSON printers only) and other print settings as necessary, and click 
Print.

Index Prints

Follow the steps below to print an index (or “contact”) sheet of selected photos in 
thumbnail size. This provides a convenient way to see all the photos in a roll or a 
selection of your favorite shots.

1. Click Index Prints. 

2. Step 1 Select Photos is highlighted. Select the roll and click on the photos 
you want to print. Click the Select All button to print all the photos in the 
roll on the index sheet.

3. Click Step 2 Print Assignment. You see this screen:

4. Select the format for the index sheet, such as 2 columns, 3 columns, or 
4 columns. Use the scroll bar to see more options. 

Select 
the layout

Check the 
desired print 
preferences

Check the Print Header or Print Footer box and then 
click Settings to print information about the photos

Check the printer settings
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Choose any options you want to use in the Print Preferences box. 

With Windows and Macintosh OS 9.x, check the Printer Settings. If the 
Printer, Media Type (EPSON printers only), or Paper Size setting is incorrect, 
click the Properties button and select the appropriate setting. (See your 
printer documentation for details.)

With Macintosh OS X, click the Properties button. Select your printer in the 
Format for menu, then select the correct Paper Size setting. (Once you’ve 
selected your printer, you can select your paper size as the Media Size setting on 
the Film Factory screen.)

5. Click Step 3 Print. Choose the number of copies. Film Factory tells you how 
many sheets of paper are required. For a closer look, click the Detailed 
Preview button.

Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M. and/or Exif Print data (not 
applicable to OS X).

6. When you are ready, click .

With Macintosh OS 9.x, you see the printer settings window. Click Print.

With Macintosh OS X, you see the printer settings window. Select Print 
Settings from the Copies & Pages pull-down menu. Then select your Media 
Type (EPSON printers only) and other print settings as necessary, and click 
Print.
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Duplicate Prints 

You can print duplicate copies of selected photos on one sheet by specifying the 
number of duplicates for each selected photo.

1. Click Duplicate Prints. 

2. Step 1 Select Photos is highlighted. 

To create one duplicate of all the photos, click the 1 copy of each button at 
the top of the screen.

To print one or more copies of selected photos, click on each photo you want. 
Film Factory displays the following at the bottom of the picture:

Click the + or – button to select the number of copies you want to print for 
that photo.

3. Click Step 2 Print Assignment. You see this screen:

Select the 
layout you 
want

Select whether 
to print a 
border, date, or 
crop marks

Check the printer 
settings



43

4. Select the size of print, such as 2 × 3 or 4 × 6. (Use the scroll bar to see more 
options.) Choose any options you want to use in the Print Preferences box. 

With Windows and Macintosh OS 9.x, check the Printer Settings. If the 
Printer, Media Type (EPSON printers only), or Paper Size setting is incorrect, 
click the Properties button and select the appropriate setting. (See your 
printer documentation for details.)

With Macintosh OS X, click the Properties button. Select your printer in the 
Format for menu, then select the correct Paper Size setting. (Once you’ve 
selected your printer, you can select your paper size as the Media Size setting on 
the Film Factory screen.)

5. Click Step 3 Print. Choose the number of copies of the previewed page you 
want to print. For a closer look, click the Detailed Preview button.

Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M. and/or Exif Print data (not 
applicable to OS X).

6. When you are ready, click .

With Macintosh OS 9.x, you see the printer settings window. Click Print.

With Macintosh OS X, you see the printer settings window. Select Print 
Settings from the Copies & Pages pull-down menu. Then select your Media 
Type (EPSON printers only) and other print settings as necessary, and click 
Print.
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Album Pages 

You can print selected photos in a photo album layout and even add captions to 
the photos. Follow these steps:

1. Click Album Pages. 

2. Step 1 Select Photos is highlighted. Select the photos in the order you want 
them to appear in your album:

� Click Select All to print photos in the order they appear in the main 
screen.

� Click on the photos individually in the order you want them to print for 
your album. As you click on a photo, a number appears at the bottom left 
corner of each photo indicating its order in the sequence.

3. Click Step 2 Choose Layout. You see this screen:

If you deselect a photo by clicking it again, the other photos are 
renumbered.

Select the 
layout you 
want

Select 
whether to 
print a border 
or date with 
the photo

Check the printer 
settings

Check the Print Header or Print Footer 
box and then click Settings to print 
information about the photos
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4. Select a layout style for your album pages, such as 3-Left, 4-Right, or 2 × 3. 
(Use the scroll bar to see more options.) 

If you want to print a border or date with the photo(s), check the appropriate 
box. 

If you want to include the roll name, check the Print Header box; to add the 
page number check the Print Footer box. For either of these, you can click the 
Settings button to change the font effects. 

With Windows and Macintosh OS 9.x, check the Printer Settings. If the 
Printer, Media Type (EPSON printers only), or Paper Size setting is incorrect, 
click the Properties button and select the appropriate setting. (See your 
printer documentation for details.)

With Macintosh OS X, click the Properties button. Select your printer in the 
Format for menu, then select the correct Paper Size setting. (Once you’ve 
selected your printer, you can select your paper size as the Media Size setting on 
the Film Factory screen.)

5. Click Step 3 Edit Layout to move your photos and text boxes anywhere on 
the album page. 

Click on the text 
box and drag it 
to move it

Add space 
for a photo

Go to previous 
or next page

Add or delete 
a text box

Save the album page
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You can click and drag an image or text box to move or resize it. 

6. To add text, select a text box by clicking on it and then click Edit Text. If your 
photos have comments, they will be displayed. Type the text you want and 
change the font, if desired, by clicking the Font button. When you are done 
making changes, click OK.

7. If you want to save the album page, click Save and enter the filename and 
location where you want to save it. (To retrieve a page, click the Album Page 
option and then click Open.)

8. Click Step 4 Print. Choose the number of copies you want. Film Factory tells 
you how many sheets of paper are required. For a closer look, click the 
Detailed Preview button.

Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M. and/or Exif Print data (not 
applicable to OS X).

9. When you are ready, click .

With Macintosh OS 9.x, you see the printer settings window. Click Print.

With Macintosh OS X, you see the printer settings window. Select Print 
Settings from the Copies & Pages pull-down menu. Then select your Media 
Type (EPSON printers only) and other print settings as necessary, and click 
Print.
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Greeting Cards 

Using the Greeting Card option, you can print selected photos and text in a 
greeting card layout, as described below.

Printing the front of the card

1. Click Greeting Cards. 

2. Step 1 Select Photo is highlighted. Select the photo you want to appear on 
your greeting card. (You can select only one.)

3. Click Step 2 Choose Layout. Select a Greeting Card Style as follows:

� If your picture is horizontal (and the card will be folded at the top), select a 
Top-Fold layout. 

� If the picture is vertical (and the card will be folded along the side), select a 
Side-Fold layout. 

4. With Windows and Macintosh OS 9.x, make sure the Printer Settings are 
correct. If not, click the Properties button and select the appropriate ones. If you 
are using the EPSON Glossy Photo Greeting Card media in an EPSON 
printer, the media type should be Photo Paper or Glossy Photo Paper for the 
outside of the card. (See your printer documentation for details.)

With Macintosh OS X, click the Properties button. Select your printer in the 
Format for menu, then select the correct Paper Size setting. (Once you’ve 
selected your printer, you can select your paper size as the Media Size setting on 
the Film Factory screen.)

EPSON offers Glossy Photo Greeting Card media designed specifically 
for EPSON Stylus® color ink jet printers. When used with Film Factory, 
your photos are printed edge-to-edge. The 8.5 × 11-inch sheets are 
perforated along three sides so you can easily remove the border after 
printing; the finished card measures 4.7 × 7 inches (119 mm × 178 mm) 
when folded. To order EPSON Glossy Photo Greeting Cards, call the 
EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. 
sales only). Use this part number: S041267.

Do not change the Orientation setting. Film Factory automatically selects 
the correct orientation for the card style you have selected.
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5. Click Step 3 Edit Layout. 

6. If you want to type text over your picture or on the back of the card, click on 
the desired text box and then click the Edit Text button. Type the text you 
want and change the font, if desired, by clicking the Font button. You can 
move or resize the text box by clicking and dragging it.

When you are done making changes, click OK.

7. If you want to save the greeting card, click Save and enter the filename and 
location where you want to save it. (To retrieve a layout, click Step 1 Select 
Photo, and then click Open.)

8. Click Step 4 Print. You should print only one card at a time, so make sure the 
number of copies is set to 1. For a closer look, click the Detailed Preview 
button.

Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M. and/or Exif Print data (not 
applicable to OS X).

Make sure your paper is loaded correctly. If you are using the EPSON Glossy 
Photo Greeting Card media in an EPSON printer, the glossy side should be 
face up and the paper’s notched corner should be on the top right corner. (See 
your printer documentation for more information about loading greeting 
cards.)

Front of 
card

Back of 
card

Select the text 
box and then 
click here to 
type (or edit) 
the text
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9. When you are ready, click . 

With Macintosh OS 9.x, you see the printer settings window. Click Print.

With Macintosh OS X, you see the printer settings window. Select Print 
Settings from the Copies & Pages pull-down menu. Then select your Media 
Type (EPSON printers only) and other print settings as necessary, and click 
Print.

10.After the card has been printed, remove it from the printer. 

If you want to print any text inside the card, see the next section.

Printing text inside the card

If you are using the EPSON Glossy Photo Greeting Card media, follow these steps 
to print text inside the card:

1. Click Step 2 Choose Layout. Select a Greeting Card Style:

� If your picture is horizontal (and the card will be folded at the top), select 
Inside Text (Top-Fold). 

� If your picture is vertical (and the card will be folded along the side), select 
Inside Text (Side-Fold).

2. With Windows and Macintosh OS 9.x, make sure the Printer Settings are 
correct. If not, click the Properties button and select the appropriate ones. If you 
are using the EPSON Glossy Photo Greeting Card media in an EPSON 
printer, the media type should be Plain Paper for the inside of the card. (See 
your printer documentation for details.)

With Macintosh OS X, click the Properties button. Select your printer in the 
Format for menu, then select the correct Paper Size setting. (Once you’ve 
selected your printer, you can select your paper size as the Media Size setting on 
the Film Factory screen.) 

Do not change the Orientation setting. Film Factory automatically selects 
the correct orientation for the card style you have selected.
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3. Click Step 3 Edit Layout. Click on the desired text box and then click the 
Edit Text button. You see this screen:

4. Type the text you want and change the font, if desired, by clicking the Font 
button. You can also click one of the alignment buttons to change the text 
alignment, if necessary. When you are done making changes, click OK.

5. If you want to save the inside layout, click Save and enter the filename and 
location where you want to save it. (To retrieve a layout, click the Step 1 
Select Photo option and then click Open.)

6. Click Step 4 Print. Make sure the number of copies is set to 1 and load the 
greeting card correctly so the inside of the card will be printed. If you are using 
the EPSON Glossy Photo Greeting Card media in an EPSON printer, the 
glossy side should be face down and the paper’s notched corner should be at 
the bottom right corner. 

For a closer look, click the Detailed Preview button.

7. When you are ready, click .

With Macintosh OS 9.x, you see the printer settings window. Click Print.

With Macintosh OS X, you see the printer settings window. Select Print 
Settings from the Copies & Pages pull-down menu. Then select your Media 
Type (EPSON printers only) and other print settings as necessary, and click 
Print.

Select left justified, centered, or 
right justified

Change the font 
style or size
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Sticker Prints

Follow these steps to print a sheet of stickers, including frames and other graphics, 
for a selected photo:

1. Click Sticker Prints. 

2. Step 1 Select Photo is highlighted. Select the photo you want to appear on 
your stickers. (You can select only one.)

3. Click Step 2 Choose Layout. You see this screen:

4. Select the Sticker Print Layout you want, such as 4 × 4 or 3 × 3. (Use the scroll 
bar to see more options.) With Windows and Macintosh OS 9.x, make sure 
the printer settings are correct; if not, click the Properties button and change 
them as necessary.

If you are using EPSON Photo Sticker paper (product number S041144), 
select 4 × 4 as the Sticker Print Layout, A6 Index card 105 × 148 mm or 
A6 4.1 × 5.8 in as the Media Size, Landscape as the Orientation, and Photo 
Quality Glossy Film as the Media Type. If you are using other media, make 
sure the settings are correct for your paper; see your printer documentation.

Select the 
layout you want

Check the printer settings
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With Macintosh OS X, click the Properties button. Select your printer in the 
Format for menu, then select the correct Paper Size setting. (Once you’ve 
selected your printer, you can select your paper size as the Media Size setting on 
the Film Factory screen.)

5. Click Step 3 Select Frame. Select the frame you want to use on your stickers 
or No frames if you don’t want any. Use the scroll bar to see additional 
choices. 

6. Click Step 4 Edit Layout. Your photo is displayed with the frame selection. 
Now you can modify the sticker as follows:

� Use the  buttons to reposition the frame. 

� Use the  and  buttons to enlarge or reduce the image.

� Add text to your photo by clicking Edit Text. Type the text you want and 
change the font and alignment if desired. Then click OK. Once the text 
frame is added, you can drag it to its final position on the sticker.

7. To save your layout, click Save and enter a filename and location for it. (To 
retrieve a layout, click Step 1 Select Photo and then Open.)

8. Click Step 5 Print. Choose the number of copies you want. Film Factory tells 
you how many sheets of stickers are required. You can click the Detailed 
Preview button to see a larger view of the sticker sheet. (See your printer 
documentation for instructions on loading sticker media.)

Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M. and/or Exif Print data (not 
applicable to OS X).

If you want to change or delete text you have added, select the text box, 
click the Edit Text button and then change it as desired.

You may want to experiment with sheets of plain paper before using 
your photo sticker sheets. To do this, cut several sheets of plain paper to 
match the size of your sticker sheets. Print a sheet of plain paper and 
then hold it up to a photo sticker sheet to test the alignment. If 
necessary, use the positioning tools in the Adjust Print Position box to 
match the photo frames to the stickers. 
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9. When you are ready, click .

With Macintosh OS 9.x, you see the printer settings window. Click Print.

With Macintosh OS X, you see the printer settings window. Select Print 
Settings from the Copies & Pages pull-down menu. Then select your Media 
Type (EPSON printers only) and other print settings as necessary, and click 
Print.

Click Main Menu to return to the main screen. 

Combo Prints 

With the Combo Prints option, you can print a single photo multiple times on 
one sheet, like you might get from a professional photo studio. Follow these steps:

1. Click Combo Prints. 

2. Step 1 Select Photo is highlighted. Select the photo you want to make a 
combo print of. (You can select only one.)

3. Click Step 2 Choose Layout. You see this screen:

Choose the layout you want

Check one of 
these boxes if you 
want borders or 
crop marks around 
each picture

Check the printer settings 
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4. Select the Combo Print Layout you want. (Use the scroll bar to see more 
options.) If you want borders or crop marks around the photos, check the box 
under Print Preferences. 

With Windows and Macintosh OS 9.x, make sure the printer settings are 
correct; if not, click the Properties button and change them as necessary.

With Macintosh OS X, click the Properties button. Select your printer in the 
Format for menu, then select the correct Paper Size setting. (Once you’ve 
selected your printer, you can select your paper size as the Media Size setting on 
the Film Factory screen.)

5. Click Step 3 Print. You see this screen:

6. Choose the number of copies you want. Film Factory tells you how many 
sheets of paper are required. Click Detailed Preview to see a larger view.

Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M. and/or Exif Print data (not 
applicable to OS X).

7. When you are ready, click .

With Macintosh OS 9.x, you see the printer settings window. Click Print.

With Macintosh OS X, you see the printer settings window. Select Print 
Settings from the Copies & Pages pull-down menu. Then select your Media 
Type (EPSON printers only) and other print settings as necessary, and click 
Print.
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Other Film Factory Features

Film Factory includes several other features that are fun and productive. You can:

� Create a photo collage

� Create a photo slide show

� Play a movie file

� Create web pages of your photos

� Use a photo as your desktop wallpaper (Windows only)

� Create a screen saver (Windows only)

� Export photos to a file or to e-mail (Windows only for e-mail)

Creating a Collage

Follow these steps to create a collage of two or more photos: 

1. From the Main menu, select the photos you want to be in the collage.

2. Click the Export button and select Create Collage. You see this window:

3. Enter the filename, file type, (JPEG, PICT, or Bitmap) and other information 
for the collage.

4. When you are ready, click Create (Windows) or Merge (Macintosh). You see 
the new collage image in your roll.

Browse to the 
folder where you 
want to store the 
collage

Specify the file 
name and type

Select 1, 2, or 3 
columns and 
the background 
color

Select the size 
(number of pixels)
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Creating a Photo Slide Show

1. From the Main Menu, select the roll and then the photos you wish to include 
in your slide show. If you want to select all photos in a roll, click All.

2. Click the Viewer button and select Slide. The Slide Show window appears.

3. Check the Auto Change box and enter the number of seconds for each photo 
to display. 

4. Check Auto Repeat if you want to continuously cycle through the photos 
until you press Esc. Otherwise, the slide show ends when all of the photos have 
been displayed.

5. Click Run to begin. You can also use the left and right arrow keys on your 
keyboard to move backward and forward through your photos. 

Playing a Movie File

As long as QuickTime 4 (or higher) is installed on your computer, you can play 
QuickTime, DV, MPEG, and AVI movie files in Film Factory. Just select the 
movie file and then select Play Movie from the View menu.

Creating Web Pages of Your Photos

1. From the Main Menu, select the roll and then the photos you want to use in 
your web pages. If you want to select all photos in a roll, click All.

2. Click the Export button and select Web Format. The Web Export Settings 
window appears.

3. Select the Export Folder where you want to store the web pages.

4. Make your Index Page settings for the main document that contains all of the 
photo thumbnails.

5. Make your Photo Page settings for the pages that display larger images when 
you click on the thumbnails.

6. Click OK. Creating the web pages may take a few minutes.

You can view your web pages with your browser and repeat the process if you wish 
to add or remove photos or make other types of changes. To post your photos on 
the web, use your usual method of transferring web pages to your web site.
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Uploading Photos

You can use Film Factory to upload your photos to the EPSON PhotoCenterSM or 
an FTP site. The EPSON PhotoCenter (at http://photo.epson.com) is EPSON’s 
exciting photo-sharing site where you can display and print your work, see what 
other photographers are doing, and learn more about digital photography (not 
available with OS X).

At the EPSON PhotoCenter, you can:

� Store and organize your photos online in password protected albums

� Share your photos with family and friends

� Print high resolution photos straight from the web on your EPSON printer

� Create free online postcards with your photos

Follow these steps to upload photos to the EPSON PhotoCenter or an FTP site:

1. Select the roll and then the photo(s) you want to upload. If you want to select 
all photos in a roll, click All.

2. Click the Export button and select Web Upload. 

3. Select Epson PhotoCenter or FTP.

4. For the EPSON PhotoCenter, type your User Name and Password. If you have 
not already created an account, click Create New Account and follow the 
instructions to sign up for a new account on the web.

For an FTP site, enter the FTP address, your username, and password.

5. Click Upload.
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Converting a Photo to Desktop Wallpaper

If you are using Windows, you can turn a photo into wallpaper for your desktop. 
(This option is not available on the Macintosh.)

1. Select the roll and then the photo you want to save as wallpaper. (Choose only 
one photo; if you select more than one, only your first selection is used.)

2. Click the Export button and select Wallpaper. The Export Wallpaper 
window appears.

3. Check Save to 256 colors if you wish to convert your photo to 256 colors. 
This saves memory, but the colors in your photo may be less vibrant.

4. Click OK. The photo is saved in the Windows folder and applied to your 
desktop.

Using a Photo Roll as a Screen Saver

If you are using Windows, you can use one or more rolls of photos as your screen 
saver. 

1. Right-click on your desktop and click Properties.

2. Click the Screen Saver tab and select Film Factory from the Screen Saver 
drop-down list.

3. Click the Settings button. On the Select Rolls tab, check the boxes for the 
film rolls you want to include in the screen saver. On the Preferences tab, 
specify how you want the screen saver to behave.

4. Click OK twice to close the Settings and Screen Saver windows.
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Exporting Photos to Files or E-mail

You may need to convert a photo to another file type or change its compression for 
use in another application. You can do this in Film Factory with the Export 
option. This option also lets you e-mail your photos to other people if you are 
using Windows.

Exporting a file in another format

1. Select the roll and then the photo(s) you want to convert.

2. Click the Export button and select To File. You see this window:

3. Enter the folder where you want to export the file (or click Browse to find it). 

4. Select the image format you want for the exported file(s) (JPEG, Exif, PICT, or 
Bitmap), and the resolution, quality, and other export settings.

5. When you are ready, click Run or Run All to convert the file(s). 

If you export a PRINT Image Matching or Exif Print photo, the exported 
file will not include the PRINT Image Matching or Exif Print data.
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E-mailing a photo (Windows only)

1. First select the e-mail program you want to use: From the File menu, select 
Preferences and then click the Mail tab. Select the program you want and 
click OK.

2. Connect to your internet service provider or network.

3. Select the roll and photo(s) you want to e-mail.

4. Click the Export button and select Send Mail. Your e-mail program should 
start and your photos should appear as attachments.

5. Use your program as you normally do to e-mail your photos.

Where to Get Help

If you’ve tried online Help, checked this guide, and still have questions, then 
contact EPSON at our website:

http://support.epson.com

Be sure to visit www.epsonsoftware.com occasionally to check for new Film 
Factory releases. 

http://support.epson.com
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